
熟悉⼩型场景（基于UE默认坐标系）和世界场景（基于纬经⾼坐标系）的原点设置⽅法。

软件要求：Windows 10及以上版本；RflySim⼯具链 。

硬件要求：笔记本/台式电脑1台 。

例程⽬录：

新建UE4.27项⽬

*此处编写实验名称*

1. 实验⽬的

2. 实验要求

[1]

[2]

3.实验地址

[安装⽬录]\RflySimAPIs\3.RflySim3DUE\1.BasicExps\e0_StarterContent\4.SetSceneOri

gin

4. 实验内容或步骤
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新建UE5.2项⽬
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**⽬标：**通过⼀个⼩型室内/建筑场景，演⽰如何临时和永久调整静态⽹格体的枢轴点，

以及将对象精确对⻬到世界坐标原点 (0,0,0)，并使⽤⽹格对⻬和捕捉⼯具进⾏精确布置。

通过Unreal Engine 4.27打开⼀个⼩型场景关卡。添加⼀个静态⽹格体（例如墙壁或⽴⽅

体）作为⽰例对象放⼊场景中。在视⼝中将其选中，确保可以看到其移动/旋转控制柄

（gizmo）。

5.1 Unreal Engine 4.27 ‒ ⼩型场景的场景原点设

置教程

步骤1 创建场景并添加对象：
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在选中对象的情况下，将视⼝切换到移动或旋转模式。将⿏标悬停在对象上，按住  Alt  键

并中键单击并拖动（即按住 Alt 键拖动中键）到对象表⾯的某个位置，这时对象的枢轴点

（Pivot）会跟随移动到新的位置。这⼀操作是在当前关卡中临时更改该实例的枢轴点，便

于从新枢轴进⾏变换。为了更精确地放置枢轴，可切换到正交视图（Top/Front等）来拖

动。完成后松开⿏标，您会看到物体的变换控件已从原始中⼼移动到了新的枢轴位置。（截

图建议："Alt+中键"拖动枢轴时的视⼝情况）

步骤2 临时调整静态⽹格体的枢轴点：
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如果希望将刚才调整的枢轴点设为永久枢轴，可以使⽤编辑器提供的 Pivot 菜单命令。保持

对象选中状态，在视⼝中**右键单击**该对象靠近您期望作为中⼼的位置，打开右键菜单。

选择 Pivot ⼦菜单下的 "Set Pivot Offset Here" （将枢轴点设置到此处）选项，这会将

枢轴临时移到您右击的那个位置（可选择不使⽤栅格对⻬或使⽤"(Snapped)"对⻬⽹格的选

项）。然后再次右键单击对象，选择 Pivot → "Set as Pivot Offset" （设置为永久枢轴偏

移）选项。这样新枢轴位置就会保存为该静态⽹格体实例的永久枢轴。取消选中后重新选择

该对象，枢轴将保持在新位置⽽不会重置。

步骤3 永久设置静态⽹格体的枢轴点：
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若需恢复默认枢轴，可选择 Pivot → "Reset Pivot Offset" 重置。
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选中需要对⻬的对象，在详情⾯板（Details）的**Transform（变换）**栏下找到

Location（位置） 属性，将 Location X、Y、Z 坐标数值全部设置为 0。这会把对象精确

移动到世界坐标系的原点处。原点是三个坐标轴交汇的特殊点，在该位置对象坐标为

(0,0,0)。完成后，您可以在视⼝看到该对象位于世界原点（通常坐标轴原点有可⻅的红/绿/

蓝轴线交叉）。如果对象较⼤（例如⼀⾯墙），可以在将其Location重置为0后，再根据需要

调整对象本⾝相对于原点的位置（例如让地板位于Z=0平⾯上）。

步骤4 将对象对⻬到世界坐标原点：
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在放置和调整场景中的多个对象时，充分利⽤UE编辑器的捕捉对⻬功能以确保精确定位：

启⽤⽹格对⻬：查看主⼯具栏顶部的⽹格捕捉按钮（类似⼩⽅格图标）。确保它⾼亮表

⽰已开启平移⽹格对⻬。当平移(移动)捕捉启⽤后，移动对象将按照设定的单位跳格对

⻬（默认步⻓10uu，即每移动10单位为⼀格)。您可以单击旁边的下拉菜单调整步⻓⼤

⼩（如1、5、10、100等单位），以匹配场景尺⼨进⾏精细布置。类似地，可以开启⻆

度捕捉（旋转图标）和缩放捕捉，分别⽤于按指定⻆度增量旋转和按⽐例缩放。

**顶点对⻬（Vertex Snapping）：**若需要将⼀个物体精确贴合到另⼀个物体的特定位

置（如两个墙块⽆缝对接），可以使⽤顶点捕捉功能。按住  V  键不放，然后拖动对

象，移动过程中会出现物体⽹格的顶点⾼亮显⽰。将源对象的某个顶点拖动到⽬标对象

的顶点上并松开，源对象的该顶点就会与⽬标对⻬，实现精确贴合（在使⽤顶点捕捉前

可以先⽤ Pivot 临时移动源对象枢轴到该顶点，以该点作为对⻬基准）。

步骤5 使⽤⽹格对⻬和捕捉⼯具精确布置：
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**表⾯对⻬（Surface Snapping）：**为了将物体放在地⾯等表⾯上，选中对象后按下

键盘End 键，物体会沿世界Z轴下落并贴靠到最近的表⾯（例如地⾯碰撞平⾯）。此功

能可快速放置物体且避免穿插。

请在需要时结合以上捕捉⼯具：例如构建房屋时，启⽤⽹格对⻬使墙壁位置对⻬整⻬，

使⽤旋转捕捉确保墙体保持90°直⻆；将家具放置在地⾯可⽤ End 键贴地；对接两个模

型边缘⽤顶点捕捉保证⽆缝连接。

将移动后的场景烘焙导⼊RflySim3D，可以看到场景原点已修改

步骤6 验证最终效果：
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X轴红⾊，决定actor向前（forward）或向后（backward），正值向前；

Y轴绿⾊，决定actor向左（left）或向右（right），正值向右；

5. 关键知识点

关键知识点1：⼩型场景原点设置（使⽤UE默认世界坐标）

UE默认坐标系
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Z轴蓝⾊，决定actor向上（up）或向下（down），正值向上；

在⼩型关卡中，通常使⽤ 默认的世界坐标系原点 (0,0,0) 作为场景参考点。为⽅便对⻬和布

置模型，你可以通过调整静态⽹格体（Static Mesh）的枢轴点（Pivot）或移动Actor的位

置来改变场景中“原点”的相对位置。以下是在 UE4.27 和 UE5.2 中设置/更改原点位置的

⽅法：

**确认世界原点：**UE4的世界坐标系原点是固定在场景中⼼(0,0,0)处，⽆法直接拖动

世界原点。因此，要改变模型相对于原点的位置，需要移动模型本⾝或者调整其枢轴

点。

临时调整静态⽹格体枢轴：**在编辑器中选中对象时会显⽰移动/旋转 gizmo，其位置

取决于对象的枢轴点。可以**暂时改变Actor的枢轴位置：按住  Alt  键并中键拖拽来

移动枢轴到模型上的新位置。也可以直接中键拖动变换控件中⼼的⼩球来临时移动枢

轴。

**永久修改Actor枢轴点（关卡中偏移）：**将枢轴移动到理想位置后，右键点击对象，

选择 Pivot > Set as Pivot Offset，即可将当前枢轴偏移保存下来。这样即使取消选中

后重新选中，该Actor在当前关卡中的枢轴也保持新的偏移位置。这对于在关卡中对⻬

多个Actor很有⽤。例如，可以将⼀个家具模型的枢轴设在底部中⼼，然后容易地将它

放置在地⾯或对⻬到世界原点。

永久修改静态⽹格资源的原点：**在UE4.27中，如果希望**从根本上改变静态⽹格体

资产的原点（Pivot），需要在建模软件中调整模型使所需枢轴位于(0,0,0)再重新导⼊，

或者使⽤UE4的建模⼯具插件。UE4⽆法直接在内容浏览器中重设⽹格的原点。解决⽅

法：启⽤ “Editor Modeling Tools” 插件，这允许在编辑器内永久修改⽹格资产的

枢轴位置。启⽤插件后，选中静态⽹格体资产，进⼊建模模式 (Modeling Mode) 使⽤

Edit Pivot（编辑枢轴） ⼯具，将枢轴设置到模型所需位置并应⽤，这会将新枢轴烘

焙到静态⽹格资产中。注意，在UE4.27中该功能可能仍为实验性质。

**将Actor对⻬世界原点：**如果想让某个对象位于世界原点处，可以在场景中直接将

其坐标设置为 (0,0,0) 或⼿动拖动对⻬⽹格中⼼。⽐如，若要以建筑物⼊⼝为场景原点

参考点，可将建筑物整体移动使⼊⼝处于世界坐标 (0,0,0)。由于世界原点本⾝不能移

动，这实际上是通过移动场景内容来“重新定位”原点。**提⽰：**使⽤对⻬和捕捉功

能（如⽹格对⻬、顶点对⻬等）可以精确定位Actor的位置。

**注意事项：**使⽤ Pivot > Set as Pivot Offset 修改的枢轴偏移只作⽤于当前

关卡中的该Actor实例，并不修改静态⽹格资产本⾝的原点。如果在其他关卡使⽤

同⼀资产，其枢轴仍是导⼊时的默认位置。要在所有实例中统⼀修改，需使⽤建

模⼯具或在DCC⼯具中重设原点并重新导⼊资源。

UE4.27：调整枢轴点与对⻬原点

12 / 21



**基本枢轴调整⽅法：**UE5.2中沿⽤了UE4的⼤部分枢轴调整⽅式。你依然可以通过

 Alt  + 中键拖动 来暂时移动Actor的枢轴点，然后右键 Pivot > Set as Pivot Offset

保存偏移。这些步骤在UE5中同样有效，作⽤也类似。

**建模模式下的枢轴编辑：*UE5对枢轴调整提供了更便捷的内置⼯具。在*建模模式

(Modeling Mode) 中，可以使⽤ “编辑枢轴 (Edit Pivot)” ⼯具直接修改静态⽹格资

产的枢轴。使⽤该⼯具：

i. 在⼯具栏左上⻆切换到“建模”模式，展开 “变换 (XForm)” 类别，找到 Edit

Pivot ⼯具。

ii. 选中需要修改的静态⽹格，在视⼝中将出现其当前枢轴位置的坐标轴标记。你可以

⼿动拖动该标记到新位置，或在细节⾯板中使⽤预设按钮快速将枢轴移到模型中

⼼、底部等位置。

iii. 点击“接受”应⽤更改。新的枢轴位置会烘焙到静态⽹格资产，因此此资产在所有

关卡中的实例都将使⽤新枢轴。这⽐UE4时代需要外部修改模型要⽅便得多。

将Actor对⻬世界原点：**与UE4相同，如果需要将对象放到世界原点处，直接将其

Location设为 (0,0,0) 即可。UE5提供**⼤型⽹格更⾼精度的位置计算（详⻅下⽂

LWC），因此即使将对象放在较远的位置也能保持精确。在⼩型场景中，通常建议将主

要场景内容布置在靠近世界原点的位置，以减少浮点误差和⽅便灯光烘焙等。

**注意事项：**UE5的枢轴编辑功能虽然强⼤，但仍应谨慎使⽤，特别是在团队协

作时更改资产枢轴可能影响已放置的场景。如果不想修改资产本⾝，也可继续使

⽤Actor级的 Pivot Offset ⽅法。临时调整枢轴（Alt+中键）在取消选择后会复

位，需使⽤“Set as Pivot Offset”才会在当前关卡中保留。

在⼤型开放世界（如GIS数据导⼊的地形、⼤地图或城市级项⽬）中，常需要将场景与真实

地理坐标系对⻬。例如，希望以某经纬度位置作为虚幻世界的原点，以便按照真实坐标放置

内容。针对 UE4.27 和 UE5.2，下⾯分别介绍如何设置地理参考原点，以及相关的 World

Composition/World Partition、世界原点重定位 (World Origin Rebasing)、

Georeferencing 地理参考插件 的使⽤⽅法和差异。

1. 启⽤ World Composition 管理⼤世界： Unreal 4.27使⽤ World Composition（世界

构成） 来管理超⼤关卡，并借助世界原点平移 (Origin Shifting) 来避免坐标精度问题。在

UE4.27中，单个关卡的坐标范围受限于引擎常量  WORLD_MAX ，⼤约±21百万UU（20km

左右）。超过此范围或距离原点太远会导致浮点精度不⾜，物理抖动等问题（通常5km以外

UE5.2：调整枢轴点与对⻬原点

关键知识点2：⼤型世界场景原点设置（使⽤真实地理坐

标）

UE4.27：使⽤ World Composition 和地理参考原点
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就可能出现抖动）。World Composition通过分块流送和动态重定位原点扩展了世界规模，

不受  WORLD_MAX  限制。

**设置步骤：**打开关卡的 World Settings ⾯板（主菜单 Window > World

Settings）。勾选 Enable World Composition 开关启⽤世界构成。启⽤后，当前关卡

将作为持久关卡，项⽬内容⽬录中所有⼦关卡（⼦地图）都会在 Levels ⾯板中列出。

通过Levels⾯板可以组织这些⼦关卡的位置层级关系，并进⾏加载/卸载控制。

原点重定位 (Origin Rebasing)：**在World Settings中**默认会启⽤ Enable World

Origin Rebasing（世界原点重定位）。确保该选项保持勾选状态，以便引擎⾃动根据

玩家位置动态平移世界坐标原点。当玩家移动过远时，引擎会将世界坐标系零点重新定

位到玩家附近，从⽽使玩家周围坐标值归零，避免数值过⼤导致的精度损失。这⼀过程

对单机游戏是⽆缝的。 (注意：如果不想使⽤动态原点平移，可⼿动关闭该选项。但⼤

型世界通常需要它来消除抖动)。

**划分⼦关卡 (Tiles)：**在启⽤World Composition后，可以将⼤地图拆分为多个⼦关

卡（如地形⽡⽚）。在 Levels ⾯板中通过拖拽⼦关卡条⽬来布置它们的相对位置。每个

⼦关卡都有⼀个 Level Bounds 定位其边界，World Composition会根据摄像机距离⾃

动流送距离内的⼦关卡。当玩家接近边缘区域时，原点会⾃动平移，保证玩家始终在坐

标中⼼附近。这避免了远离原点时的抖动问题。

**验证原点平移：**在编辑器的World Composition视图中，能够看到当前世界原点的

位置（有⼀个坐标⼗字标⽰）以及安全编辑区域等信息。当你编辑⾮常远处的⼦关卡

时，编辑器也会⾃动暂时平移世界原点以⽅便编辑，保存时会转换回原始绝对坐标，不

影响实际数据。

2. 使⽤地理参考 (Georeferencing) 插件设置真实坐标原点： UE4.27引⼊了

GeoReferencing（地理参考）插件，可以将虚幻世界与真实地理坐标联系起来。启⽤该插

件后，你可以指定关卡在某⼀地理坐标系下的原点位置，并使⽤经纬度或投影坐标放置对

象。具体步骤：

**启⽤插件：**在编辑器菜单选择 Edit > Plugins，搜索并启⽤ Georeferencing 插件

（地理参考系统）。启⽤后需要重启编辑器。插件启⽤后，会在引擎内容中提供

GeoReferencing相关的Actor和功能。

**放置地理参考系统Actor：**在 Place Actors ⾯板中搜索

“GeoReferencingSystem”（若未出现，需在Place⾯板中勾选显⽰ Engine Content

引擎内容）。将 GeoReferencingSystem 拖⼊场景。这是⼀个全局地理参考设置

Actor，选中后在细节⾯板可以配置坐标系参数。

**配置坐标系：**在GeoReferencingSystem的细节⾯板下，找到 Geo Referencing

部分。主要配置：

Planet Shape（星球形状）：选择 Flat 平⾯或 Round 椭圆体。对于区域较⼩的场

景（⼏平⽅公⾥以内），可以使⽤Flat+投影坐标系；对于覆盖⼤范围或需要使⽤经
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纬度的场景，选择Round (如地球椭球)更为合适。Round模式下默认椭圆体为

WGS84地球模型。

Projected CRS / Geographic CRS（投影坐标系/地理坐标系）：指定所采⽤的投

影或地理坐标参考系。默认情况下，插件使⽤EPSG:4326 (WGS84地理坐标) 作为

Geographic CRS。如果有具体的投影坐标系（如UTM投影）要求，可在

Projected CRS 字段填⼊对应EPSG代码。

**设置关卡原点的地理坐标：**接下来，在 Origin Location 设置中定义虚幻世界原点

对应的真实坐标。通常有两种⽅式：

如果采⽤投影坐标系（如UTM平⾯坐标），勾选 “Origin Location in Projected

CRS”，然后填⼊原点的东向(Easting)、北向(Northing)坐标和⾼程。这些值应为

整型或尽量简洁的数字（最好以⽶为单位且不带⼩数），可选择你项⽬区域内某基

准点作为原点。例如，将城市坐标减去⼀个偏移量，使某建筑中⼼成为(0,0)。

如果采⽤地理坐标系（经纬度），取消勾选 Origin Location in Projected CRS（使

⽤地理坐标定义原点）。然后填⼊ Origin Latitude（纬度）、Origin Longitude

（经度）和 Origin Altitude（海拔）。例如，输⼊你的GIS数据参考原点的经纬度

⾼程。(在选择Round Planet模式下，需要定义这个原点在地球上的经纬度位置)。

**注意：**若使⽤经纬度，需确保模型X轴指向东、Y轴指向北，Z轴向上，以匹配

真实⽅位。

**应⽤效果：**完成以上设置后，(0,0,0) 世界坐标将对应你设定的真实地理原点。例

如，如果Origin Latitude/Longitude设置为北京天安⻔的位置，那么关卡原点就代表

地球上的天安⻔坐标。此时可以通过插件提供的函数在虚幻坐标和地理坐标间转换。

**使⽤真实坐标放置对象：**GeoReferencing插件提供了蓝图和C++函数，将经纬度或

投影坐标转换为UE世界坐标并放置Actor。例如，在蓝图中使⽤ Georeferencing 分类

下的 “Longitude/Latitude To Engine” （或 Geographic To Engine）节点，将

输⼊的经纬度转换为  FVector  世界坐标，再将Actor移动到该位置。反之，也可以将

Actor的世界位置转换回经纬度（Engine To Geographic）。由于插件内部使⽤双精度

进⾏计算，转换⾮常精确。举例来说，你可以读取GIS数据库中的道路节点经纬度，通

过上述函数得到UE坐标后，在场景中⽣成道路标记Actor。

**验证坐标正确性：**UE4.27附带⼀个⽰例 BP_GeoReference 或

GeoReferencingSystem 能显⽰当前摄像机位置的经纬度等信息，或使⽤插件⾃带的

坐标状态栏 (GeoReference Status Bar) UMG⼩⼯具显⽰视⼝中⼼点的地理坐标，⽅

便调试。

World Composition 与地理参考配合：*World Composition负责*空间管理和流式

加载，GeoReferencing插件负责坐标转换**。两者可以配合使⽤：你可以通过

GeoReferencing设置某地理点为世界原点，同时World Composition在幕后进⾏⼦关

卡加载和原点重定位。当玩家跨越⻓距离时，World Composition会触发原点平移，但

GeoReferencing系统使⽤双精度计算，会跟踪新的原点偏移，确保经纬度转换依然准
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确。Epic提供的BP_Rebase⽰例展⽰了如何在需要时⼿动控制原点重定位，但⼀般情

况下⾃动机制已够⽤。

注意事项（UE4 ⼤世界）：

性能和精度：**启⽤World Composition和原点重定位后，尽量让玩家始终

位于世界坐标较⼩的位置，可最⼤程度避免精度问题。UE4的⽹络多⼈游戏

默认**不⽀持原点重定位，为防⽌不同客⼾端坐标不⼀致。如果要在多⼈游

戏中使⽤，需要在项⽬设置中启⽤ “Enable Multiplayer World Origin

Rebasing”（实验性，可能有不稳定）。单⼈游戏则可以安全地使⽤此功能。

**坐标系选择：**对于区域较⼤的项⽬，推荐使⽤投影坐标系作为中间参考。

例如，城市级地图可采⽤UTM坐标（如WGS84 UTM Zone）或国家坐标系，

将区域坐标换算为以⽶为单位的平⾯坐标，再设置为Origin Projected

Coordinates。这避免了直接使⽤经纬度（度为单位）在计算中带来的⻆度转

距离计算开销。

**整型原点：**尽可能选择整数值的原点坐标（尤其投影坐标）。例如，将原

点定在UTM坐标的整万⽶位置。这是因为浮点原点可能引⼊细微偏差。整数

原点有利于后续所有位置计算都更加⼲净准确。

UE5对⼤世界的⽀持进⾏了⼤幅改进，引⼊了 World Partition（世界分区） 系统，并实现

了 Large World Coordinates (LWC) ⼤世界坐标（64位精度）⽀持。总体上，UE5.2可以

更轻松地创建和管理巨⼤场景，同时更准确地表⽰远距离位置。以下是UE5.2中设置⼤型地

理场景原点的⽅法：

**1. World Partition 替代 World Composition：**在UE5中，World Composition已被弃

⽤。取⽽代之的是 World Partition，它⾃动将单⼀关卡划分为⽹格并流式加载，不再需要

⼿⼯管理⼦关卡。

**启⽤⽅式：**新建UE5项⽬时，⼤多数模板（第三⼈称、⻋辆等）已经默认使⽤

World Partition。对于UE4⽼项⽬，可以通过菜单 Tools > Convert Level 将关卡转换

为World Partition格式。转换后，所有⼦关卡会合并⼊⼀个持久关卡，Actors按空间位

置划分到分区⽹格单元中。

流式加载设置：**World Partition下，打开 **World Settings**，在 “World

Partition” 部分确保 **Enable Streaming**（启⽤流送）为**勾选状态。如果使⽤

的是基本模板项⽬，默认虽然⽤了World Partition但可能关闭了流送（整个关卡始终加

载）。为了模拟⼤世界按距离加载，需要开启该选项。开启后，可使⽤ World

Partition 窗⼝ 查看和调节⽹格加载半径、Data Layers等。UE5还⽀持 One File Per

Actor 来优化团队协作，每个Actor保存为单独⽂件，多⼈可同时编辑不同区域。

UE5.2：使⽤ World Partition 和地理参考原点

16 / 21



原点管理与LWC：**UE5引擎核⼼坐标改为双精度（LWC）后，世界坐标精度上限⼤

⼤提⾼。据Epic开发者所述，UE5的64位坐标允许场景**理论上可扩展到类似太阳系

尺度⽽不出现明显抖动。这意味着在UE5单机游戏中，⼀般不再需要频繁进⾏原点重定

位。例如，在UE4中5公⾥外可能出现的物理抖动，在UE5可以推迟到极远距离才会发

⽣。然⽽，需要注意的是，渲染管线和物理引擎的某些部分仍然使⽤32位浮点，因此

当距离原点特别极端时，仍可能出现抖动或精度问题（例如有报告指出在数百公⾥外微

⼩⽹格会出现轻微颤动）。因此UE5虽然缓解了原点问题，但在极⼤规模下仍可选⽤原

点重定位作为补充⼿段。

多⼈游戏原点：**UE5中**默认仍禁⽤多⼈原点重定位。如果制作⼤世界多⼈游戏，可

在 Project Settings > Network 中⼿动启⽤ “Enable Multiplayer World Origin

Rebasing”。这会让服务器为每个客⼾端独⽴平移世界以减⼩坐标，但实现复杂且需

仔细处理同步，通常结合锁步或其他⽅案。

**2. UE5 地理参考原点设置（Georeferencing 插件）：**UE5.2沿⽤了4.27引⼊的地理参考

插件，并进⾏了改进。其使⽤⽅法与UE4基本⼀致：

**启⽤插件：**在 编辑 > 插件 中打开 GeoReferencing 插件（在UE5中仍归类于

Built-in Plugins）。启⽤并重启编辑器。随后在Place Actors中即可找到地理参考相关

Actor。

**添加 GeoReferencingSystem：**将 GeoReferencingSystem Actor 拖⼊关卡（同

样需要在Place⾯板启⽤“显⽰引擎内容”来找到）。选中它，在细节⾯板配置参数：

**Planet Shape：**选择 Round Planet（椭圆体）或 Flat Planet。若你的项⽬涉

及⼤范围经纬度（例如整个城市或更⼤区域），请选择 Round Planet，以使⽤地球

椭圆体计算曲率。Flat模式适合很⼩区域且不需要考虑地球曲率的情况。

**坐标参考系 (CRS)：**默认情况下，Projected CRS 和 Geographic CRS 字段会

填⼊⼀些初始值（如EPSG:4978地⼼坐标、EPSG:4326地理坐标）。⼀般保持默认

即可，或者根据需要修改。其中EPSG:4326表⽰WGS84经纬度坐标，常⽤于GPS

坐标。如果有特定的投影坐标（如中国2000坐标或某地⽅坐标系），可以在

Projected CRS中填⼊对应EPSG代码。

**关卡原点 (Origin Location)：**根据使⽤的坐标系输⼊原点值：

若使⽤Projected CRS（平⾯坐标），保持 Origin Location in Projected

CRS 为勾选状态，在 Origin Projected Coordinates 下填写该原点在投影坐

标系下的东、北、上数值（单位⽶）。例如采⽤UTM坐标，可将场景中⼼的

UTM Easting/Northing输⼊进来作为(0,0)。

若使⽤Geographic CRS（经纬度），先取消勾选 Origin Location in

Projected CRS，然后填写 Origin Latitude、Origin Longitude（单位为度）

以及 Origin Altitude（单位⽶）。例如，将Origin Latitude/Longitude设为

你城市模型对应的地理位置坐标。填写后，该经纬度点就作为UE世界原点。
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经纬度坐标转换：*和UE4类似，UE5的地理参考系统提供函数在地理坐标与UE坐标间

转换。UE5中可以直接使⽤ **GeoReferencingSystem** 的组件函数，或在蓝图中使

⽤ **“Geographic To Engine”**、*“Engine To Geographic” 等节点。⽐如，

在蓝图中调⽤ Convert LongitudeLatitudeAltitude To Unreal，输⼊经度、纬度、

⾼度结构体，将输出⼀个 Vector 位置。这样可以⽅便地根据真实坐标放置Actor。由

于UE5⽀持更⼤的世界范围，这些转换在全球尺度上依然有效。

**⽰例：**假设你有⼀份城市GIS数据，其参考坐标系为WGS84经纬度，并希望UE关卡

原点对应城市中⼼点。你可以在GeoReferencingSystem中取消Projected CRS，填写

城市中⼼的纬度经度。然后，对每条道路的数据⽤“经纬度转UE坐标”函数换算出

Vector，在这些位置⽣成道路⽹格或Spline。这些Actor将在正确的地理位置出现。使

⽤Round Planet模式还能考虑地球曲率，使得如果场景跨度极⼤，位置仍然准确（通

常城市规模误差可忽略）。

Large World Coordinates 优势：**UE5的双精度坐标让上述过程更加可靠。即使你

的关卡原点被设置为地球上⼀点，场景中的坐标可能达到上百万，但由于内部使⽤64

位精度，可以保持精确定位。在UE4时代，可能需要每隔⼀段距离⼿动Origin

Rebasing⼀次，⽽在UE5单⼈情况下，⼤多数项⽬**⽆需⼿动重定位原点，这极⼤简

化了跨越⼤范围移动时的位置管理。不过，如果你计划模拟全球尺度（如⻜⾏模拟器）

或者⻓时间在极端远离原点的位置运⾏，仍需考虑结合原点重定位来避免某些浮点着⾊

器的精度问题。

注意事项（UE5 ⼤世界）：

**性能优化：**World Partition引⼊了数据层、HLOD等系统⽤于⼤规模场景

优化。利⽤ Data Layers 可以将某些不随距离卸载的关键内容（如全局环境）

设置为始终加载层，⽽地形、建筑等使⽤距离流动。合理划分数据层和设置

流加载半径，能确保地理参考原点⽆论在哪⾥，玩家周围都有平滑加载的环

境。

**精度与物理：*虽然LWC缓解了⼤部分精度问题，但*物理引擎 (Chaos) ⽬前

也逐步⽀持双精度。如果你的项⽬涉及⾼精度物理运算且范围极⼤，关注引

擎更新。必要时，可以采⽤“分区物理原点”的思路，即让物理计算以局部

原点进⾏（这需要⾼级实现，不是内置功能）。

**第三⽅⼯具：**对于沉浸式GIS集成，社区还有例如 Cesium for Unreal、

ArcGIS Maps SDK 等插件，它们内部也使⽤GeoReferencing系统并提供在线

地图流服务。如果项⽬需要可视化全球数据，不妨考虑这些⼯具，和UE5内置

地理参考配合使⽤以简化⼯作流。

本节将简要解释CesiumGeoreference（地理参照）和 UE 世界坐标的关系，帮助初学者

理解在球形地球上构建场景时坐标转换发⽣了什么。

CesiumGeoreference 与世界坐标转换逻辑简述
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**地理坐标系 vs UE坐标系：**地球上的位置通常⽤经度、纬度和⾼度（WGS84⼤地坐

标）来表⽰，⽽ Unreal 引擎内部使⽤的是笛卡尔直⻆坐标系（X/Y/Z轴）来定位对象。

Cesium for Unreal 插件通过 CesiumGeoreference 对象将这两种坐标系联系起来。

CesiumGeoreference 定义了 UE 世界坐标原点在地球上的对应位置，以及世界坐标轴

相对于地理⽅向的对⻬⽅式。简单来说，我们可以指定⼀个经纬度作为 UE 场景的原

点，那么该经纬度点就在引擎中映射为 (X=0, Y=0, Z=0) 的位置。此时引擎的 +X ⽅向对

应东向、+Y 对应南向，+Z 则对应该地点的正上⽅（指向天空⽅向）。

原点转换（Origin Rebasing）：**由于地球是球体⽽UE场景通常近似平⾯，⼀个场景

不可能覆盖整个星球⽽保持每处都⾼精度和正确向上⽅向。CesiumGeoreference 提

供了**动态原点平移机制：默认情况下，当观察者（相机）移动较远距离时，

CesiumGeoreference 会⾃动将世界原点重新设置到靠近观察者的新位置。这种平移确

保玩家附近的对象坐标值较⼩，避免浮点精度问题，并使本地的“向上”⽅向始终贴合

当前位置的地表法线。UE5 引⼊了“双精度⼤世界坐标（Large World

Coordinates）”，极⼤提⾼了⼤范围场景的位置精度，减轻了坐标过⼤引起的抖动问

题。但即便如此，在地球另⼀端（与原点相距数千公⾥），重⼒⽅向将相差近180°⸺

也就是说，如果不调整坐标系，远离原点的地⽅引擎认为的“下”已不是地⼼⽅向，会

导致物体产⽣物理错误（例如⻆⾊会“飘”离地表）。通过及时调整原点位置或使⽤⼦

关卡分别定位不同区域，可以避免这⼀问题。Cesium 动态Pawn 默认包含

CesiumOriginShift 组件，会在跨越⼀定距离时触发原点更新，使场景坐标系跟随玩

家位置移动。

**锚点与坐标变换：**对⼀般的UE Actor⽽⾔，其位置是固定在当前世界坐标系下的。

如果我们改变了 CesiumGeoreference 原点，这相当于整体移动/旋转了地理坐标系与

世界坐标的映射，那么原点变化前放置的普通Actor位置会随着坐标系变化⽽发⽣偏

移。在前⾯的步骤中，我们看到当修改原点后，FloatingPawn 没有⾃动跑到北京，就

是因为Pawn原本没有⾃⾝的地理锚定，它的世界坐标没有变但地理参考系变了，导致

它实际上留在先前的地理位置。为了解决此问题，Cesium 提供了

CesiumGlobeAnchor 组件：给Actor添加该组件后，Actor 会按照地理坐标定位，从

⽽在改变原点时仍保持在同⼀真实地点不动。换句话说，锚定对象遵循地球坐标系，⽽

⾮固定的UE世界坐标。当原点平移或重定位时，所有具有 GlobeAnchor 的对象都会依

据新原点⾃动更新其世界坐标，从⽽持续“贴”在原本的经纬度位置上。

对于室内、单栋建筑等⼩型场景，⼀般⽆需移动世界原点，⽽是通过调整模型的枢轴

和位置来实现所需的原点对⻬。UE4.27需要借助插件或DCC⼯具来永久修改资产原

点，⽽UE5.2提供了直接编辑资产枢轴的⼯具，提⾼了⼯作效率。始终将关键对象放在

世界原点附近可以获得更好的数值稳定性和渲染效果。

在UE4.27中，⼤型场景需要借助World Composition将世界划分、并通过World

Origin Rebasing维持精度；同时利⽤Georeferencing插件可以让虚幻坐标对应真实经

总结：
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纬度，实现GIS数据对接。在UE5.2中，World Partition⾃动管理⼤地图，Large

World Coordinates⼤幅提升了坐标精度上限；地理参考插件延续使⽤，使关卡原点可

精准锚定到指定经纬度。选择适合项⽬规模的原点设置⽅案：⼩范围场景以(0,0,0)默认

原点为中⼼即可；超⼤范围则应采⽤地理参考原点和分区技术，并注意精度和性能细

节。通过上述⽅法，你可以在不同规模的项⽬中正确设置原点位置，既⽅便内容对

⻬，⼜确保运⾏稳定可靠。

Cesium for Unreal 通过 CesiumGeoreference 将地理空间引⼊UE，引擎5.2的双精度

⼤世界⽀持让整个地球作为⼀个关卡成为可能。开发者需要了解原点的位置和对象锚

定的重要性：将原点设在当前关注区域，确保局部坐标精度与⽅向正确；对需要固定

在地理位置的对象使⽤锚点，以免原点变化时出现偏移。

1. 

2. 

3. 

A1：打开关卡的 World Settings ⾯板（主菜单 Window > World Settings）。勾选

Enable World Composition 开关启⽤世界构成。启⽤后，当前关卡将作为持久关卡，项

⽬内容⽬录中所有⼦关卡（⼦地图）都会在 Levels ⾯板中列出。同时确保 Enable World

Origin Rebasing（世界原点重定位）保持勾选状态，以便引擎⾃动根据玩家位置动态平移

世界坐标原点。

A2：⾸先在编辑器菜单选择 Edit > Plugins，搜索并启⽤ Georeferencing 插件，重启编

辑器后⽣效。接着在 Place Actors ⾯板中搜索并放置 GeoReferencingSystem Actor到场

景中。选中该Actor后在细节⾯板中配置坐标系参数，包括选择星球形状（Flat或Round）

6.参考资料

RflySim官⽅⽂档

Unreal Engine 4.27 Documentation

Unreal Engine 5.2 Documentation

7.常⻅问题

Q1：在UE4.27中，如何启⽤World Composition

来管理⼤世界？

Q2：如何在UE4.27中使⽤地理参考

(Georeferencing)插件设置真实的地理坐标原点？
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和坐标系类型（Projected CRS或Geographic CRS）。最后在 Origin Location 设置中定义

虚幻世界原点对应的真实坐标，可以是投影坐标系下的东向、北向坐标，或是地理坐标系下

的纬度、经度和海拔。

A3：UE5.2对枢轴调整提供了更便捷的内置⼯具。在建模模式 (Modeling Mode) 中，可以

直接使⽤ "编辑枢轴 (Edit Pivot)" ⼯具修改静态⽹格资产的枢轴。具体操作是在⼯具栏左

上⻆切换到"建模"模式，展开 "变换 (XForm)" 类别，找到 Edit Pivot ⼯具。选中需要修

改的静态⽹格，在视⼝中将出现其当前枢轴位置的坐标轴标记，可以⼿动拖动该标记到新位

置，或在细节⾯板中使⽤预设按钮快速将枢轴移到模型中⼼、底部等位置。点击"接受"应⽤

更改后，新的枢轴位置会烘焙到静态⽹格资产，因此此资产在所有关卡中的实例都将使⽤新

枢轴。这⽐UE4时代需要外部修改模型要⽅便得多。

1.  

2. 推荐配置请⻅：  

Q3：UE5.2相⽐UE4.27在枢轴点调整⽅⾯有什么

改进？

https://rflysim.com/ ↩
https://rflysim.com/doc/zh/HowToInstall.pdf ↩
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